Introduction to using the beta ScalableLearning platform for flipped classroom teaching.
Version 0.5, March 2014.
Please send all questions and comments to david.black-schaffer@it.uu.se.

Introduction ...........................................................................................................................................2
Moving to Flipped Classroom Teaching ..............................................................................................3
    Assumptions .....................................................................................................................................3
    Basic steps ........................................................................................................................................3
How long does it take? .............................................................................................................................3
Helping students get the most from flipping .......................................................................................3
    Example 1: Required for Grade ........................................................................................................4
    Example 2: Bonus points on the exam .........................................................................................4
Step 1. Split your lectures into 5-10 minute segments ...........................................................................5
Step 2. Develop self-assessment questions for each segment ...............................................................6
Step 3. Develop in-class problems for active learning ......................................................................7
Step 4. Record your lectures and add online interactivity ...................................................................8
Step 5. Teaching with ScalableLearning and Flipped ........................................................................9
Tips and Tricks ..................................................................................................................................11
    Presentations .................................................................................................................................11
    Recording .......................................................................................................................................11
    Equipment .....................................................................................................................................12
Getting Started with ScalableLearning: Logging In ..........................................................................13
Viewing your Courses .........................................................................................................................14
Create a new Course ..........................................................................................................................15
    Course Forum [Optional] .................................................................................................................16
Main Menu ..........................................................................................................................................18
    Progress ..........................................................................................................................................18
    In-class ..........................................................................................................................................18
    Calendar .........................................................................................................................................18
    Announcements .............................................................................................................................18
    Content ..........................................................................................................................................18
    Information .................................................................................................................................18
Creating a Module ..................................................................................................................................19
Adding a Video Lecture ........................................................................................................................21
Adding Quizzes to Lecture Videos .......................................................................................................23
Recording Videos ...............................................................................................................................27
    Setting Up the Screen .....................................................................................................................27
    Recording .......................................................................................................................................29
    Trimming .......................................................................................................................................29
Uploading Videos to YouTube .............................................................................................................31
Setting Your YouTube Videos as Unlisted or Public ........................................................................33
Reviewing Quizzes and Questions for In-class Use .........................................................................34
Reviewing Quizzes and Questions In-class .......................................................................................37
Previewing your course as a student ..................................................................................................40
Student Accounts .............................................................................................................................41
Introduction

Flipping your classroom allows you to have students spend in-class time on active learning by putting your lectures online. In addition, you can add interactivity to your lectures by including self-assessment quizzes to make them more effective.

This document gives an overview and tips for how to prepare and record your presentations for flipped classroom teaching.
Moving to Flipped Classroom Teaching

Assumptions
1. Your lectures consist of computer-based presentations with you talking and advancing the presentation.
2. You want to record your computer screen and audio for your online lectures.
3. You want to include online self-assessment quizzes and in-class active learning.
(If your class is based on on-the-board lectures, you can record them in a similar fashion with a document camera, which will record what you write on a piece of paper.)

Basic steps
Flipping your classroom by recording your lectures and adding online interactivity consists of four steps:
1. Split your lectures
2. Develop self-assessment questions
3. Develop in-class problems
4. Record your lectures
I strongly encourage you to go through a whole lecture with steps 1-3 before you start recording. Fundamentally, it is the value you generate in steps 2 and 3 that is the real teaching benefit of this approach.

How long does it take?
The most time demanding part by far is converting your courses to this new format with in-lecture quizzes and in-class practice problems. (Recording the video itself is quick in comparison.) Expect to spend a significant amount of time working with your lecture material to develop good in-lecture quiz questions (short, but helpful) and in-class practice problems (longer, but more structured). But while this takes a lot of time, you should remember that this is the real value of flipping the classroom: you are adding content that makes your courses more interactive, and that leads to more active student learning.

Helping students get the most from flipping
To make this teaching approach work you need to get the students to actually watch the online content and do it on time. This can be a challenge, particularly for students who have hitherto felt that all aspects of a course were optional. There are several approaches to this, but the most important thing is to make sure that the time they spend on the material directly helps them in passing the course. Our experience has been that once students see that this approach is an effective way to learn the material, they stop complaining.

However, getting them to see that this is a helpful way to learn can be a challenge. To reach most students the most effective approach is make the online content and in-class problems a required (graded) part of the course. (After all, most students optimize their time for the grade, not the actual learning.) However, there are many ways to do this. Two that have worked for us are making in-class attendance and online lectures required (reduced grade for missed lectures) or providing bonus points
(increased grade for attending). In the required case, it is important to provide flexibility for students who are sick or have conflicts.

**Example 1: Required for Grade**
This approach requires students to watch the lectures and come to class as part of their grade, but provides flexibility:

- Students are required to watch the lectures before each class
- Students are required to attend the in-class practice sessions (attendance sheet is passed around in class)
- Failure to do either of the above reduces the participation portion of the grade to a 0.
- However, students are allowed 8 “late days” if they cannot make a deadline. These late days do not extend future deadlines.
- If a late day is used for an in-class practice session, then the students have to turn in written solutions.

This approach gives students flexibility when they need it, but forces the students to participate in the online and in-class activities. This approach also provides a strong incentive for attending the in-class practice sessions in that it is far less work to do the problems with a partner in-class than to do them at home and turn in a written solution. The overhead is keeping track of the late days, although very few students will ever use up all 8.

**Example 2: Bonus points on the exam**
This approach makes the online lectures and in-class portions of the class optional, but gives students bonus points on the exam if they complete them:

- Students who watched 10/12 of the online lectures on-time receive bonus points on the exam
- Students who attended 5/6 of the in-class meetings receive bonus points on the exam (attendance sheet is passed around in class)

This approach avoids “requiring” students to do any extra work, but gives them a strong incentive to do it. The overhead is in adjusting the final exam grades with the bonus points.
Step 1. Split your lectures into 6 minute or shorter segments
1. Each segment should have a logical topic
2. You should add title slides for each segment
3. I recommend doing this in the slide sorter view of your presentation program.
4. This means you only have to re-record short amounts if you make a mistake or need to change something

Typically each section will have no more than 5 slides. You should try hard to keep the videos to at most 6 minutes both avoid boring the students (watching a long uninterrupted video is intensely boring) and to make it easier for you to re-record if you need to change something. The 6-minute figure comes from a 2013 study by Philip Guo, et. al. (“How Video Production Affects Student Engagement: An Empirical Study of MOOC Videos” in the ACM Conference on Learning at Scale) in 2014. They found that beyond 6 minutes student engagement dropped off significantly. They also recommend the following:

- **Shorter videos are more engaging.** Keep the segment time to less than 6 minutes. This is the most important recommendation.
- Videos that switch between the material and the instructor are more engaging, although this is harder to produce. Don’t switch too much as it is distracting.
- A more personal feel is helpful. E.g., in an office rather than in a studio.
- Tablet drawings are more engaging than (static) slides. The motion and visual flow from animations is very helpful in keeping students engaged.
- Recorded classroom lectures do not work as well as purpose-produced short segments.
- **Fast speaking and high enthusiasm from the instructors are important.** (The students can always pause or rewind, so don’t worry about speaking too quickly.)
- Lectures and tutorials are different. For lectures the key part is the experience of someone watching it for the first time. For tutorials students navigate through them more, so an overview and clearly visible labels are more important.
Step 2. Develop self-assessment questions for each segment

1. Typically you want between 10 and 20 1-minute questions for every hour of lecture time
2. You should have at least one question for each lecture segment
3. For each question, you will need to put together an answer
   a. Explanation of how the correct answer is correct
   b. Short explanations for why each incorrect answer is wrong
4. If you can not come up with a good 1-minute question to test the material in a lecture segment, you should evaluate:
   a. Should this segment be split up further? (E.g., is there too much/too complex material to test?)
   b. Should this segment be removed? (E.g., is the material untestable, in which case it may not be worth spending time on.)
5. There are two main ways to add self-assessment questions to online lectures:
6. Put the questions into your lecture
   i. This allows you to have them in your presentation
   ii. You get to introduce them as part of the lecture
   iii. You get to explain the answer as part of the lecture
   iv. But, you can’t change them without re-recording that part of the lecture
7. Insert the questions into the lecture after recording
   i. This allows you to change/add questions without re-recording
   ii. But, you have to keep them separate from the presentation (e.g., you need to keep track of them in a separate file)
   iii. You don’t get to introduce/explain the question as easily since it isn’t part of the presentation
Step 3. Develop in-class problems for active learning

1. There are many types of these and they vary depending on the type of course you are teaching. Here are some suggestions:
   a. In-class small group problems
      i. Develop 10 minute long problems for students to solve in groups of 2-3
      ii. Each problem should have multiple sub-problems
      iii. The idea is that the struggle a bit with sub-problem A, you then walk the class through the answer to A, and then they can do B on their own
      iv. In-class you describe the problem and then let the students start working as you go around the class and help them. When most students have gotten stuck or finished part A you go through the solution with the class and move on to part B.
   b. In-class discussions
      i. Develop a topics for 10-minute long discussions within small groups
      ii. The groups should summarize their discussions in 2 or three short statements
      iii. You can then ask the students for a few of their key summaries and discuss them with the class
   c. Problem Based Learning
      i. Develop larger more open-ended problems
      ii. The students then work on different aspects of them in 10 minute chunks
      iii. (There are many detailed approaches to “PBL”, so please choose your favorite reference for this one!)

2. Hints about in-class assignments:
   a. They are typically not graded to avoid putting pressure on the students
   b. You need to keep the class on schedule so students don’t feel they are wasting time or being too rushed. (This takes practice so don’t feel bad if you are struggling with it the first few times.)
   c. You need to be aware that some students will finish far sooner than others. Providing extra “challenge problems” for those students is often appreciated.
   d. You (or the students) will find mistakes in your problems. Use these as positive examples of the student’s intelligence and admit them and discuss them in-class.
   e. It takes several iterations to get these assignments to be appropriately clear and about the right length.
   f. Provide plenty of room on the handouts for students to write, and remind them that the answers are available to download online (and make sure they are) so they don’t race to write down the solutions.
Step 4. Record your lectures and add online interactivity

1. You will need a screen capture program, and a place to store your videos online, a microphone, and a quiet room (see Tips and Tricks below)
2. Close your door.
3. Start your presentation software in full screen mode and start your screen recorder.
4. Record each lecture segment.
5. (Edit them if needed.)
6. Upload the videos.
7. Create the lectures on scalable-learning.
8. Put in the URL to the video you uploaded.
9. Add your quizzes to the lecture.
Step 5. Teaching with ScalableLearning and Flipped

Once your students have watched your online lectures and answered the questions you can use the information from their answers to help focus your in-class discussion on the material they found most challenging. The ScalableLearning system has built-in support to make this as easy as possible, but as a teacher you need to be careful to make sure that you use the in-class time primarily for active learning and not reviewing the online lecture! (This is difficult as most of us are used to lecturing and have a hard time giving it up.)

1. Before class:
   - Use the Progress information to review how students answered the quizzes and what questions they posted during the lecture.
   - Use the In-class view to choose which quizzes and student questions you want to review in-class.
     - Remember that reviewing a question or quiz will take 2-4 minutes and the goal is to spend most of your class time on active learning, not review.
     - Keep in mind that the students have already seen the answers to the quiz questions both when they clicked on the answer and when they continued the video.

2. In-class: Review
   - Start with a 5-10 minute review of the key concepts and issues covered in the online lecture.
     - For this I take a few slides from the online lecture and combine them with a general overview/outline and final conclusions.
     - If you are very ambitious you can tailor this review based on the online feedback.
   - Spend 5-10 minutes reviewing the online quizzes and questions.
   - Give students positive feedback about their answers and questions:
     - For good questions tell the class that these are great questions.
     - For questions/quiz results that reveal a problem with the quiz or the lecture be honest and tell them that this was your fault and you appreciate their feedback.
     - Once you get used to this kind of feedback it is a lot of fun to come into class knowing the questions and problems ahead of time. Be sure to convey enthusiasm for being able to adapt your teaching to their needs.

3. In-class: Practice problems
   - This part takes practice, so do not feel bad if it does not go smoothly at first.
   - Be sure to walk around and talk to the students. Look over their shoulders, listen to what they are discussing, and provide helpful and encouraging comments.
   - Tell the students explicitly that it is fine for them to tell you to go away if they want to work on the problem on their own.
   - Give them a few minutes to get started before you go around and offer help.
   - If (when) you see that many students are having similar issues with a question stop the class and help them get through it. Working with the
students in this way will very quickly reveal problems with your questions!

- Watch the time: try to spend about 10 minutes on a typical problem, and don’t feel bad about going on if not everyone has got it.
- Be careful about student groups that use a lot of your time and student groups that never seem to want your help. You need to make a conscious effort to engage the students who don’t ask for help and a conscious effort to avoid being monopolized by those who constantly do.
Tips and Tricks

In-class

- A classroom with tables is ideal
- A lecture hall can work very well if you have students sit in every other row so you can go between them
- Tell students it is okay to tell you to go away if they want to work on your own
- Don’t wait for students to ask for help
  - Go around to everyone and look over their shoulders and listen to their conversations, offer advice
  - You will quickly figure out which students are too shy to ask for help, which don’t want it, and which take up too much of your time
- Be prepared to shout at the class to stop (it can get very noisy)
- Make sure you manage the time so you don’t spend too long on any problem

Presentations

- Help students know where to focus their attention
  - Use animations in your presentations that help students see where to focus their attention and understand the flow of your material.
  - Do not display large amounts of text all at once on a slide. Have text appear as you discuss it so students know where to focus their attention and do not read ahead.
  - Use the mouse pointer when you present to point to the relevant parts of the screen. This makes it easier for students to know where to pay attention and makes the lecture seem more personal.
- Always start each lecture segment with a short overview of what you will talk about and where it fits into the bigger picture.
- Don’t worry about small mistakes: think of this as a recorded in-class lecture. If you make a small mistake just explain that it was a mistake and keep recording. If you make a big mistake, then consider re-recording it.

Recording

- Be enthusiastic and engaged. Don’t worry about speaking slowly as students can always pause and rewind if they need to.
- Stare at the screen as you present imagining the students sitting right on the other side.
- Try a test recording to make sure the audio is loud enough and there are no echoes from walls.
- Make sure your microphone does not bump into your clothing.
- Do not move around relative to the microphone or your voice will get louder and softer.
- Always review portions of each video to make sure there aren’t any technical mistakes (missing sound, background noises, etc.)
- Do not record too large files. You want to set your screen to be 1280x720 resolution (widescreen) or 1024x768 (normal) when you record to record HD movies. You can do this with your system settings. If you record at higher
resolutions you will create enormous files that will just be reduced in size when you post them online.

- Some people like to include videos of themselves in their recordings. This takes more effort and requires that you have good lighting in your recording room and that you look into the camera while recording. I do not recommend it since you will see the students in-class anyway.

**Equipment**

- Microphone
  - Lavalier/Lapel microphones are best, but new Mac laptops won’t detect them unless they have the right plug. You can fix this with a cheap USB audio card.
  - The RODE smartLav microphone is another excellent choice.
  - USB microphones will also work.
  - I use the microphone on my iPhone headset, but I need to make sure the cable does not bang into my shirt.

- Uploading videos
  - Once you have recorded videos you need to put them on a server. I recommend YouTube, but you can use Vimeo or your own server if you prefer.
  - To use YouTube, you need a google account (either a gmail one or you can create a new one for free).
Getting Started with ScalableLearning: Logging In

1. Browser: We strongly recommend the Chrome browser (www.google.com/chrome/). Newer versions of Safari and Firefox should work as well. Older versions of Internet Explorer will not work.

2. Account: You should have received teacher account information from us before getting started.

3. Logging in: Go to www.scalable-learning.com to log in. Enter your email address and password.
   a. Choose “remember me” to avoid having to log in each time.
   b. You can change your password and email address by clicking “Edit account” once you are logged in.
Viewing your Courses

- When you log in you will see the “My Courses” list by default.
- You can get back to this page by clicking on “Courses” at the top of the screen.
Create a new Course

1. Go to the “My Courses” page by clicking on “Courses” in the top menu bar.
2. Click “New Course”
3. Define the course by filling in the fields

- Short Name: 1DT038
- Name: Introduction to Computer Architecture
- Start Date: 2013-10-14
- Duration: 6 weeks
- Discussion Forum Link: piazza.com/uu.se/spring2013/1
- Description: Innehåll: Analyse och syntheses av komplexa kretsar och synkrona sekvenskretsar. Realisering av digitala kretsar i programmabel logik av PLD.
- Prerequisites: 15 hp from technical-natural sciences. Algebra I and SMT (Programkonstruktion och Datastrukturer ska vara)
- Time Zone: Stockholm

- Short name is the typically the code for the course. E.g., “1DT038 or AVDARK”
- The duration is the number of weeks the course lasts
- [Optional] The discussion forum link can point to any discussion forum you would like to use. We strongly recommend using piazza (see below).

4. [Optional] You can copy contents (including lectures and quizzes) from another course you have taught with the “Import Data From” popup. If you do not have any other scalable-learning courses this will be empty.
5. Click “Create Course”

After you have created the course you will see the course information page. The Course Enrollment Key is what students use to enroll in the course. When you start your course you will need to send out an email to the whole class via your University enrollment system to all students telling them to enroll using that key.

You can edit the course information in the future by choosing “Information” → “Course Information” from the menu bar and then clicking on the pencil edit icon at the bottom.

Course Forum [Optional]

1. Create a forum wherever you prefer.
   a. We recommend using piazza.com because it is far better than any of the university provided forums, but it requires students to create an account.
   b. To create a piazza forum, simply go to piazza.com and create a new class.

2. Get the class link for the forum
   a. For piazza, click on “Manage Class” and then copy the “Class link” link.
   b. For other forums, go to the forum and copy the link from the address bar in the web browser.
<table>
<thead>
<tr>
<th>Class Information</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Course Number:</strong></td>
</tr>
<tr>
<td><strong>Course Name:</strong></td>
</tr>
<tr>
<td><strong>Class Term:</strong></td>
</tr>
</tbody>
</table>

*To see Placza for 107065 for a different term, click here to create a new class.*

**Course Start Date:**
01/13/2013

**Signup Link:** plazza.com/u/se/spring2013/107065

**Class Link:** plazza.com/u/se/spring2013/107065/home

*This is the link to your course page on Plazza.*
The main menu contains the following options for working with your class:

**Progress**
- View how your students are doing during the class
- Review whether they have completed lectures
- Review how students did on quizzes

**In-class**
- Choose questions and quizzes to review in-class
- Display questions and quizzes during your class meeting

**Calendar**
- Mimics what the students see so you can check due dates.

**Announcements**
- Post and send announcements to the whole class
- Announcements show up both on the students login page (their calendar) and are emailed to all students in the class.

**Content**
- Add modules, videos, quizzes, and handouts
- Organize the content of the course
- Set due dates

**Information**
- Course Information: edit/view basic course information, including the enrollment key
- Enrolled Students: see a list of all students enrolled in the course
- Teachers: see a list of all teachers/TAs in the course, and add/remove TAs and teachers
Creating a Module

A course consists of multiple Modules, which group video lectures (with integrated quizzes), independent quizzes (graded or not), un-graded surveys, and links to handouts. Typically students will be responsible for completing a given module before coming to class. (E.g., you will likely put all the material from a traditional in-class lecture into one module, and then have it due the day before the class meeting.)

1. Click on “Content” in the main menu
2. Click “Add Module” to add a new module
   a. You can delete the module by clicking on the trashcan next to it.
   b. You can view the contents of a module by clicking on the + sign.
   c. You can re-order modules by dragging the arrows to the left.
3. To edit the module click on its title
   a. Note that the module will display the total time (sum of all the video times) and the number of questions inside the videos (lecture questions) and independent quizzes (quiz questions).
4. Enter the name, the date the module should be visible to the students, and the date the module are due on the right under “Details”. Click “Save Module”. The due dates are at midnight on the date specified. (E.g., if you have it due on Tuesday, it will be due at midnight on Tuesday.)
5. [Optional] To add a document (e.g., a PDF of handouts) to the model:
   a. Click “Add Document”
b. Click the pencil icon to edit the document

![Image of a document editor interface]

- Add a new document by entering a name and URL in the provided fields.
- Click “Save” to store the document on your webserver.

- **c.** Enter the name and URL for the document and click “Save”. The document must be stored on a webserver somewhere. (E.g., your university web server or a google doc.)

6. To put video lectures, independent quizzes, or surveys into a module, click on the + next to the module name to expand it and click “Add Lecture”, “Add Quiz”, or “Add Survey”.

![Image of a module structure interface]

- **Introduction**
  - New Module
  - New Quiz
  - New Survey
  - Add Lecture
  - Add Quiz
  - Add Survey
Adding a Video Lecture

1. Click “Add Lecture” in the module where you want to insert the video lecture.

2. Click on the New Lecture title to edit it.

3. Enter the title of the lecture and the URL under Details and click “Save Lecture”
   a. The URL for the lecture is the URL of the video you wish to show. For YouTube, simply copy the video URL directly from YouTube or from the YouTube Video Manger.
   b. Copy the URL from a YouTube video:
c. Copy the URL from the YouTube Video Manager (where you upload videos):

4. Paste the video URL into the “Lecture ULR” field and the video will now appear:

5. Choose “widescreen” from the Aspect Ratio popup if your video is widescreen.
6. You can change the video lecture’s appearance and due dates if you want them to be different from that of the whole module and add a description.
7. You can also add a ULR to a set of slides if you want to provide slides for this video in the “Slides” field.
Adding Quizzes to Lecture Videos

1. Go to the video lecture where you want to insert quizzes by clicking on the lecture inside the module.
2. Click “Edit Full Screen Mode”

3. Play the video (or drag the play head) to the point where you want to insert a quiz.
4. Insert a quiz by clicking “Insert Quiz (Over Video)” or “Insert Quiz (Text)”

   a. Insert Quiz (Over Video) lets you place buttons directly on your video. This is used when you have recorded the quiz text as part of your video lecture.
   b. Insert Quiz (Text) lets you write the text for the quiz. This is used when you want to put a quiz into a video that is not written in the recorded video lecture.
   c. For both types of quizzes you can insert:
      i. MCQ - Multiple: Multiple choice questions where multiple answers can be correct. (E.g., chose n of m.)
      ii. MCQ - One: Multiple choice question where only one answer can be correct. (E.g., choose 1 of m.)
      iii. Drag into order: Students drag text answers into a specified order.
5. For (Over Video) quizzes, when you add a quiz it will be added to the list:

   ![Quiz interface](image)

   a. Click on the pencil icon to put the quiz question into the question field (“New Quiz”). This is so you can see the question when you are viewing the quiz results. The Quiz Question should be the actual question that is asked of the students, or a shortened version of that.

   ![Question input](image)

   b. Click on the quiz (the blue question text) to edit the quiz.

c. You can add answers to the video by double-clicking on the video where you want students to click on the answers.

![Video with answers](image)

d. If you put an answer in the wrong place you can drag it to the right place:

![Draggable answer](image)

6. Once you have put your answers in place, you need to fill in the information about which one(s) are correct and explanations for the students.
a. Click on the choice and choose whether it is correct, as well as entering the following text:

   i. Answer: The text the students choose. (This is used so you can see which answer is which in the graphs of how students did.) It should be the same as what is shown in the video.

   ii. Explanation: This is what the student sees if he or she selects this answer. Explain why incorrect answers are wrong and right answers are right. Explaining incorrect answers is very much appreciated by the students.

7. For “Drag Into Order” quizzes, you create new draggable boxes and put them in the right place on the screen. Students then get them in a different order and have to drag them to the right place.

   a. For each draggable item you can click on it to enter why this is the right place for it, as well as why it does not go in the other places.

8. When you are done defining a quiz click the “Done” button to save the quiz.

9. For (Text) Quizzes, clicking insert quiz will bring up a blank page where you can define the quiz questions and answers. This page will be shown over the video when the students get to the quiz.

   a. You can add more answers by clicking on the “Add answer” button and delete them by clicking on the trash icon.

10. When you are done adding all the quizzes to a video you can click “Exit Full Screen Mode” to return to the content view.
Recording Videos

How you record a video depends a bit on what type of computer and program you are using.

- For the Mac we recommend:

<table>
<thead>
<tr>
<th>Program</th>
<th>Record Yourself</th>
<th>Auto scaling to 1280x720</th>
<th>Start/Stop Shortcut</th>
<th>Trimming Ends of Video</th>
<th>Auto Upload to YouTube</th>
<th>Cost</th>
</tr>
</thead>
<tbody>
<tr>
<td>QuickTime Player</td>
<td>(complex)</td>
<td>(complex)</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Free</td>
</tr>
<tr>
<td>ScreenFlow</td>
<td>Yes</td>
<td>(stop)</td>
<td>Yes</td>
<td>*</td>
<td>*</td>
<td>700SEK</td>
</tr>
<tr>
<td>Screen Record</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>*</td>
<td>*</td>
<td>35SEK</td>
</tr>
<tr>
<td>Screen Record Studio</td>
<td>Yes</td>
<td>(soon?)</td>
<td>Yes</td>
<td>*</td>
<td>*</td>
<td>105SEK</td>
</tr>
<tr>
<td>iScreen Record Pro</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>*</td>
<td>*</td>
<td>80SEK</td>
</tr>
<tr>
<td>U2Any Screen Recorder</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>*</td>
<td>*</td>
<td>100SEK</td>
</tr>
<tr>
<td>Screeny</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>*</td>
<td>*</td>
<td>100SEK</td>
</tr>
<tr>
<td>Camtasia</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>*</td>
<td>*</td>
<td>100SEK</td>
</tr>
<tr>
<td>Snagit</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>*</td>
<td>*</td>
<td>700SEK</td>
</tr>
<tr>
<td>Screenium</td>
<td>Yes</td>
<td>(complex)</td>
<td>Yes</td>
<td>*</td>
<td>*</td>
<td>260SEK</td>
</tr>
<tr>
<td>Screencast Maker</td>
<td>Yes</td>
<td>(complex)</td>
<td>Yes</td>
<td>*</td>
<td>*</td>
<td>280SEK</td>
</tr>
<tr>
<td>Adobe Presenter</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>*</td>
<td>*</td>
<td>35SEK</td>
</tr>
<tr>
<td>Video Express</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>14SEK</td>
</tr>
</tbody>
</table>

* Supports this indirectly by opening in QuickTime Player after recording.

- Note that the programs that scale the screen by themselves will make the mouse pointer really small. You can make it larger with programs such as ScreenFlow and Camtasia, or with utilities such as Keymo ($5), PinPoint ($5). (The built-in MacOS X pointer enlargement does not get recorded.)

- For Windows we recommend:
  - Camtasia (170EUR, lots of features, record yourself as well)
  - Snagit (30EUR, simple screen recorder)
  - Adobe Presenter ($500, lots of features)
  - (There are lots of other free utilities, which we have not tried.)

- Most of these programs will easily upload your videos directly to YouTube for hosting.

Setting Up the Screen

4. When you record your video you don’t want to make it too large. Normally people have their computer screens set to full HD resolution (1920x1080). For recording videos you want to reduce this resolution to reduce the file sizes. Typically you want 1280x720 for widescreen (or 1024x768 for non-widescreen presentations if you don’t want the black on the sides).
5. On a Mac: Apple Menu → System Preferences → Displays

- Choose “scaled” and then select either 1280x720 for widescreen or 1024x768 for normal presentations. (Do not use widescreen for non-widescreen slides or you will just end up recording a lot of black on the sides.)

6. On Windows: Control Panel → Hardware and Sound → Display → Change Display Settings → Resolution

7. When you change the resolution to a lower one than what you usually use, everything will look larger and blurry. This will not be a problem because the video will record fewer pixels (the resolution is lower) and will look fine. When you are done recording set your screen back to the previous values.
Recording

8. To record, launch your presentation program and your screen recording program.

9. Tell your screen recorder to start recording.
   - This is typically done by choosing “New Screen Recording” or typing a special key combination.
   - Make sure your microphone is recording well and close the door!
   - Once you have started recording, switch your presentation into full screen mode and record your presentation.
   - When you are done, stop the recording either by clicking on the stop button or using the special key combination.

Trimming

10. Once you have recorded your video, you need to trim off any starting or ending parts you don’t want in your video.

11. Treating can be done on your own computer or in YouTube after you have uploaded the video.
   - In QuickTime Player you choose “Trim” from the Edit menu and drag the yellow handles. Drag them until any extra material at the start or end is removed and click Trim.
If you want to trim after you have uploaded your video, choose Edit → Enhancements in the YouTube video manager:

Then click on the trim scissors at the bottom and drag the handles at the left and right:

Once you have recorded your video we recommend you save a copy on your computer in case you want to edit it again or upload it to another service. (You can re-download it from YouTube, but it will have been recompressed.)
Uploading Videos to YouTube

Most video capture programs let you directly upload a video to a YouTube account. Otherwise you have to save the video to your local computer, log into YouTube, and drag the video into the YouTube upload window to upload it.

- In QuickTime Player choose File→Share→YouTube and use your YouTube account information:

- To upload a video manually, log into your YouTube account with your web browser and click on “Upload”

- Then drag the files to the upload icon to upload them:

- When you first upload a movie, YouTube will process it. This can take several minutes depending on the size of the movie. Until it is done being processed
you cannot view or edit the movie.
Setting Your YouTube Videos as Unlisted or Public

When you upload YouTube videos they can be public (anyone can see them and find them by searching), private (only google accounts you allow can see them), or unlisted (anyone with the right URL can view them, but no one can find them via search). You should keep your videos either public or unlisted.

12. Go to the YouTube Video Manager.

13. Click “Edit” on your video:

14. Set your desired privacy settings and save the changes:

Privacy settings

Unlisted

Anyone with the link can view
Reviewing Quizzes and Questions for In-class Use

Before coming to a class meeting you will want to review how your students did on the video quizzes and see what questions they had.

15. To review this material go to the “Progress” tab and click on the module you wish to view:

- At the top you see the statistics on how many students have not started watching the class, watched less than 50%, completed it on time, and completed it late.

16. This view shows you:

- **Lecture Quizzes**: How students did on each lecture quiz. You can click on the title (Question 1) to see the question in the video:

- **Lecture Statistics**: Shows you where students clicked the “confused” button, the “rewind” button, the “pause” button, and asked questions during the lecture. This view is shown as a timeline so you can see which parts of your lecture were most confusing. Clicking on a part of
the graph will bring you to that location in the lecture:

**Progress:** shows you which students have completed which parts of the assignments and which ones are early or late

**Lecture Progress Chart**

<table>
<thead>
<tr>
<th></th>
<th>ISA introduction</th>
<th>MIPS instructions</th>
<th>MIPS memory</th>
<th>Instruction execution model</th>
<th>Data operations</th>
<th>Data transfer instructions</th>
<th>Sequencing instructions</th>
<th>Sequencing example</th>
<th>ISA 1 summary</th>
</tr>
</thead>
<tbody>
<tr>
<td>Robert</td>
<td>✓</td>
<td>✓</td>
<td></td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Mikael</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Marcus</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Jimmy</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Vale L.</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Frondik</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Hannah</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
</tbody>
</table>
- **Surveys**: shows you student responses to any surveys in the module.

You can respond to student questions/comments by clicking on them. Students will receive an email saying you answered their question but that you don’t know who they are (since the surveys are anonymous). You can respond to multiple questions at the same time by selecting them, and you can hide questions by clicking on the checkbox in the hide column:

<table>
<thead>
<tr>
<th>Hide</th>
<th>96</th>
<th>bye</th>
</tr>
</thead>
<tbody>
<tr>
<td>21</td>
<td>A summary of all the questions, so you can easily check all the questions at the end.</td>
<td></td>
</tr>
<tr>
<td>22</td>
<td>Architecture: Why MIPS?</td>
<td></td>
</tr>
<tr>
<td>23</td>
<td>Explain what MIPS is, I missed that :P</td>
<td></td>
</tr>
<tr>
<td>24</td>
<td>The introduction.</td>
<td></td>
</tr>
<tr>
<td>25</td>
<td>none that I can come to think of</td>
<td></td>
</tr>
<tr>
<td>26</td>
<td>I feel the introduction could be a little more explanatory of what the actual lecture is about with:</td>
<td></td>
</tr>
<tr>
<td>27</td>
<td>So far so good</td>
<td></td>
</tr>
<tr>
<td>32</td>
<td>What exactly is a MIPS processor?</td>
<td></td>
</tr>
</tbody>
</table>

A MIPS processor is a processor that was developed
Reviewing Quizzes and Questions In-class

Before coming to class you should select the student questions and in-video quizzes you want to review. To do this you use the In-class menu.

1. Choose “In-class”
2. Click on the module you want to prepare
3. Click on Review Quizzes or Review Questions to select quizzes and questions to review. Choose “skip” or “hide” for all quizzes or questions you do not want to review in-class:
4. When you are in-class, open the web browser to this page and then choose “Display Quizzes” or “Display Questions” to review the ones you have selected. Make sure you maximize your browser window and make sure you are on a good network connection so the lecture videos load quickly. (We recommend plugging into a wired connection.)

5. The in-class display shows the part in the video where the question/quiz was located along with either the student question or the quiz results at the bottom:

What does add r3, r1, r0 do?

6. You can go to the next/previous question by clicking on the >> and << buttons. You can move the video backwards or forwards by 5 seconds with the “+5” and “-5” buttons. You can play the video and unmute/mute the audio with the play/mute buttons.
   - Hint: Use the +/-5 buttons to walk through any animations around the time of the question/quiz.
   - For student questions, the questions are grouped in 30 second intervals, so you may have similar questions showing up together.
When you are done click “Exit” in the lower left corner.
Previewing your course as a student
To preview your course as a student we have created a “test-student” account that you can use (user name: test-student@email.com, password: test-student) or you can create your own.

You can then log into the test-student account and add your course to see it from the student’s perspective. To make sure that your web browser does not get confused about having two logged in accounts, we recommend that you use the “New Private Window” or “New Incognito Window” in FireFox or Chrome to create a separate, private browsing session. You can then log in as the test-student with that session.
Student Accounts
Before your course starts you should send an email to your enrolled students along the following lines:

Dear Student,
    This term we will be using an online system to make your learning experience more interactive. To use this system you will need to create an account and add this course. To do so, please visit: http://www.scalable-learning.com/#/users/student and create a student account with your university email address. You can then add the course by clicking on “Add Course” under “Courses” and entering the course Enrollment Key XXXXXX.
    Sincerely,
    Teacher

You can find the Enrollment Key for your course under Information → Course Information.